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GP-3300T/L Control Class (FLEX NETWORK Type) → STC-6300TA

Easy! Smooth!
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*Products may be changed or discontinued without notice. Please check our website for the latest information.
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Update History

Date Edition Updated 

Slide

Description

2024/03/08 1st - Newly created

2024/08/23 2nd 49 Added information of the workarounds for Blink function on STC6000 Series
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Legal Information

The Pro-face brand and any trademarks of Schneider Electric SE and its subsidiaries referred to in this guide are the property of Schneider Electric 

SE or its subsidiaries. All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished for informational use only. No part of this guide may be 

reproduced or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), for any purpose, without 

the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or its content, except for a non-exclusive and personal 

license to consult it on an "as is" basis. Schneider Electric products and equipment should be installed, operated, serviced, and maintained only by 

qualified personnel.

As standards, specifications, and designs change from time to time, information contained in this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by Schneider Electric and its subsidiaries for any errors or 

omissions in the informational content of this material or consequences arising out of or resulting from the use of the information contained herein.

As part of a group of responsible, inclusive companies, we are updating our communications that contain non-inclusive terminology. Until we 

complete this process, however, our content may still contain standardized industry terms that may be deemed inappropriate by our customers.
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Safety Information

Important Information
Read these instructions carefully and look at the equipment to become familiar with the device before trying to install, operate, service, or maintain it. The 

following special messages may appear throughout this documentation or on the equipment to warn of potential hazards or to call attention to information that 

clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only by qualified personnel. No responsibility is assumed by Schneider Electric for 

any consequences arising out of the use of this material. 

A qualified person is one who has skills and knowledge related to the construction and operation of electrical equipment and its installation and has received 

safety training to recognize and avoid the hazards involved.
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About this book

Document Scope
This guidebook introduces the procedures to replace a unit from “GP3300T/L Control Class (FLEX NETWORK Type)” to “STC-6300TA”.

The recommended substitute models are as follows.

Model in use Recommended substitutes

GP-3300T/L

Control Class

FLEX NETWORK Type

GP-3300T PFXGP3300TADFN

(AGP3300-T1-D24-FN1M)

→

STC-6300TA PFXSTC6300TADDKE

（Sink Output Type）
or

PFXSTC6300TADDCE

（Source Output Type）

GP-3300L PFXGP3300LADFN

(AGP3300-T1-D24-FN1M)
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About this book

Validity Note
This documentation is valid for this product.

The technical characteristics of the device(s) described in the present manual also appear online at www.pro-face.com.

The characteristics that are described in the present document should be the same as those characteristics that appear online. In line with our policy of constant 

improvement, we may revise content over time to improve clarity and accuracy. If you see a difference between the document and online information, use the online 

information as your reference.

Registered Trademarks
Product names used in this manual may be the registered trademarks owned by the respective proprietors.

Related Documents
You can download the manuals related to this product, such as the software manual, from our website.

https://www.proface.com/en/download/search

Product Related Information
If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

https://www.proface.com/en/download/search
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About this book

Critical alarm indicators and system functions require independent and 

redundant protection hardware and/or mechanical interlocks.

When you cycle power, wait at least 10 seconds after it has been turned off. If 

this product is restarted too quickly, it may not operate correctly.

In the event the screen cannot be properly read, for example, if the backlight is 

not functioning, it may be difficult or impossible to identify a function. Functions 

that may present a hazard if not immediately executed, such as a fuel shut-off, 

must be provided independently of this product. The machine's control system 

design must take into account the possibility of the backlight no longer 

functioning and the operator being unable to control the machine or making 

mistakes in the control of the machine.

For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 

Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 

edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 

Adjustable-Speed Drive Systems" or their equivalent governing your particular location.
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About this book

The following characteristics are specific to the LCD panel and are considered normal 

behavior:

• LCD screen may show unevenness in the brightness of certain images or may appear 

different when seen from outside the specified viewing angle. Extended shadows, or 

crosstalk may also appear on the sides of screen images.

• LCD screen pixels may contain black and white colored spots and color display may seem 

to have changed.

• When experiencing vibrations within a certain frequency range and vibration acceleration is 

above what is acceptable, the LCD screen may partially turn white. Once the vibration 

condition ends, the whitening of the screen is resolved.

• When the same image is displayed on the screen for a long period, an afterimage may 

appear when the image is changed.

• The panel brightness may decrease when used for a long time in an environment 

continuously filled with inert gas. To prevent deterioration of panel brightness, regularly 

ventilate the panel. For more information, please contact customer support.

https://www.pro-face.com/trans/en/manual/1015.html

https://www.pro-face.com/trans/en/manual/1015.html
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Cybersecurity

Cybersecurity Guideline
Use this product inside a secure industrial automation and control system. Total protection of components (equipment/devices), systems, organizations, and

networks from cyber attack threats requires multi-layered cyber risk mitigation measures, early detection of incidents, and appropriate response and recovery

plans when incidents occur. For more information about cybersecurity, refer to the Pro-face HMI/IPC Cybersecurity Guide.

https://www.proface.com/en/download/manual/cybersecurity_guide

https://www.proface.com/en/download/manual/cybersecurity_guide
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1. Summary

On replacement from GP-3300T/L (FLEX NETWORK) to STC-6300TA, the following points are the main points to note.

• STC-6300TA is compatible with Modicon TM3 module, which are recommended as a replacement for FLEX NETWORK I/O unit. For a list of recommended 

substitutes, please refer to 2-4. Option Compatibility – FLEX NETWORK I/O units. FLEX NETWORK I/O units cannot be used with STC-6300TA.

• There are two ways to connect TM3 modules to STC-6300TA. Please check the next page for details.

• Connect using [TM3 driver] as the I/O driver. *To connect 3 or more TM3 units, Transmitter/Receiver units (P/N: TM3XTRA, TM3XREC1) are needed.

• Connect using [EIP driver] as the I/O driver. *EtherNet/IP compatible adapter unit (P/N: TM3BCEIP) is needed.

• Since the I/O drivers used are different, the I/O driver settings set in the GP-3300T/L (FLEX NETWORK) project will not be carried over to the STC-6300TA 

after conversion. You need to configure the I/O driver settings on the software again. For information on how to set up the I/O driver, please refer to 

Modicon TM3 guidebook for setting up a connection to HMI.

• Display resolution: STC-6300TA has a better resolution. You need to convert resolution by the software to use old project data from GP-3300T/L.

• External dimensions: The panel cut dimensions are the same, but the external dimensions are slightly different. It is necessary to check the dimensions of 

the HMI installation location.

STC-6300TA

GP-3300T/L 320 x 240 pixels (QVGA) STC-6300TA 640 x 480 pixels (VGA)

GP-3300T/L W167.5 x H135 x D59.5 mm STC-6300TA W169.5 x H137 x D60 mm

GP-3300T/L

https://www.proface.com/en/download/guidebook/tm3
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1. Summary

There are two ways to connect TM3 modules to STC-6300TA. Choose one that best suits your environment.

Connection method Connecting using [TM3 Driver] as the IO driver Connect using [EIP driver] as the I/O driver

*EtherNet/IP compatible adapter unit (P/N: TM3BCEIP) is needed.

Installation 

Environment

・When adding I/O within 5m distance from STC-6300TA

・When there are fewer than 8x TM3 modules to be added

・ If you want a simple setup

・When adding I/O within 5m~100m distance from STC-6300TA

・ When it is necessary to install on multiple local stations

(Can be connected to up to 32x TM3BCEIP)

・If you want to connect to modules such as Safety module (Modicon TM3 

Safety) other than digital and analog I/O units.

Configuration image

Hardware 

requirements

• STC-6300TA

• TM3 modules

When connecting 3 or more TM3 modules, the following optional items are required.

• Transmitter (TM3XTRA1)

• Receiver (TM3XREC1)

• Dedicated cable for connecting transmitting and receiving modules

• STC-6300TA

• TM3 modules

• EtherNet/IP compatible adapter unit (P/N: TM3BCEIP)

• Communication cables (LAN)

Software 

requirements

• GP-Pro EX (TM3 Driver is used as the I/O driver.) • TM3 Bus Coupler IO Configurator

• GP-Pro EX (EIP Driver is used as the I/O driver.)

How to set up Refer to Chapter 10 “When using TM3 modules as local expansion I/O with 

STC6000” in Modicon TM3 guidebook for setting up a connection to HMI.

Refer to Chapter 9 “When using TM3 modules as Remote I/O (EtherNet/IP)” 

in Modicon TM3 guidebook for setting up a connection to HMI.

https://www.proface.com/en/download/guidebook/tm3
https://www.proface.com/en/download/guidebook/tm3
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2. Hardware Section
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2-1. GP-3300T/L (FLEX NETWORK) vs STC-6300TA Specification Comparison -1. Basic Information-

GP-3300T GP-3300L STC-6300TA Points to note when replacing

Display Type TFT Color LCD Monochrome LCD TFT Color LCD

Display Size 5.7” 5.7”

Resolution 320 x 240 pixels (QVGA) 640 x 480 pixels (VGA)
Need to change resolution setting 

by Software

Effective display area (W x H) 115.2 x 86.4 mm 115.2 x 86.4 mm

Display colors
65,536 colors (no blink)

16,384 colors (with blink)

Black and White

(16 shades)
262,144 colors No blink function

Backlight
White LED (Rev6)

CCFL (not Rev6) 
CCFL (not user replaceable) White LED (not replaceable) Backlight is not replaceable.

Backlight service life
50,000 hours or more (before backlight 

brightness decreases to 50%)

58,000 hours or more (before backlight 

brightness decreases to 50%)

50,000 hours or more

(before backlight brightness decreases to 25%)

Brightness control 8 levels (Adjusted with touch panel or software) 16 levels (Adjusted with touch panel or software)

Touch panel type Resistive film (analog, single touch) Resistive film (analog, single touch) 

Touch panel resolution 1,024 x 1,024 1,024 x 1,024

Touch panel service life 1 million times or more 1 million times or more

Application

memory

Screen area FLASH EPROM 6MB FLASH EPROM 64MB

Refer to FAQ for the available 

capacity of each memory.

Logic Program FLASH EPROM 132KB (15,000 steps) FLASH EPROM 132KB (15,000 steps)

Backup

memory

Screen area SRAM 320KB NVRAM 320KB

Variable area SRAM 64KB NVRAM 64KB

Battery (clock data 

backup)

Rechargeable battery / 

Secondary battery for clock data backup

Replaceable battery / 

Primary battery for clock data backup
Battery can be replaced by user.

Rate Input Voltage DC24V (Input voltage limits: DC19.2~28.8V) DC24V (Input voltage limits: DC19.2~28.8V)

IP Rating IP65f, NEMA#250 TYPE 4X/13 IP65f, UL 50/50E, TYPE 1/4X/12/13

External Dimensions W167.5 x H135 x D77.6 mm W169.5 x H137 x D60 mm The dimensions are different.

Panel Cut Dimensions W156 x H123.5 mm W156 x H123.5 mm

Power Consumption 26W or less 11.3W or less

https://www.pro-face.com/trans/ja/manual/1082.html
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*1: CANopen interface will be supported. Please contact our Customer Service for the latest information.

NOTE: For more details about specification, please refer to STC6000 Hardware Manual.

GP-3300T GP-3300L STC-6300TA Points to note when replacing

Serial I/F COM1 RS-232C/422/485 (D-Sub 9pin Plug) RS-232C/422/485 (D-Sub 9pin Plug) Please refer to 2.5. Other important notes on 

Hardware in this document.
COM2 RS-422/485 (D-Sub 9pin Socket) -

Ethernet I/F 10BASE-T/100BASE-TX (RJ-45) x1 10BASE-T/100BASE-TX (RJ-45) x1

USB I/F Type A USB 1.1 (Type A)  x1

-USB transfer cable (CA3-USBCB-01)

USB 2.0 (Type A) x1 No screen data transfer via Type A

Micro B - USB 2.0 (micro-B) x1

-USB transfer cable(PFXZUSCBMB2) or commercial USB 

micro-B transfer cable

CF Card I/F Yes - To keep using the functions that were working with 

CF Card, use a USB Memory instead.

CANopen I/F - CANopen Master Embedded *1

Expansion Unit I/F Connect Expansion Unit with communication feature - The expansion unit (such as CC-LINK Unit) for 

GP-3300 series cannot be used.

Expansion Module I/F

(TM3 module / EX module）
- TM3 module / EX module x 1

Up to 2x modules by Direct mounting

Up to 8x modules by Extension mounting

For Extension mounting, Transmitter (TM3XTRA1) 

and Receiver (TM3XREC1) are needed.

FLEX NETWORK I/F Bit variable input: 512 points, Bit variable output: 512 points, 

Integer variable input: 128 points, 

Integer variable output: 128 points, 

Connector: 6pin

- The recommended substitutes for FLEX 

NETWORK I/O unit is TM3 module, connecting via 

EtherNet/IP communication. TM3 bus coupler 

TM3BCEIP is required as an EtherNet/IP adapter.

DIO I/F Digital IN/OUT - Sink/Source input: 16 points

PFXSTC6300TADDKE (Sink output): 16 points

PFXSTC6300TADDCE (source output): 16 points

Connector: 38 pin

HSC (high speed counter) 

Max.100kHz

- 4x Fast IN (among 16 IN)

PTO (pulse train output) 

Max. 65kHz

- 4x Fast OUT (among 16 OUT)

2-1. GP-3300T/L (FLEX NETWORK) vs STC-6300TA Specification Comparison -2. Interfaces-

https://www.proface.com/en/download/stc6000/manual/hardware
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2-2. Standards Compatibility

Certification GP-3300T/L (FLEX NETWORK) STC-6300TA

CE (EN61000-6-4, EN61000-6-2, EN61131-2)

UKCA -

UL/cUL (UL508)

(CSA C22.2 No.142)

(UL61010-2-201)

(CSA C22.2 No.61010-2-201)

UL/cUL Class 1, Div. 2 (ANSI/ISA12.12.01)

(CSA C22.2 No213)

(UL121201)

(CSA C22.2 No213)

ATEX (Zones 2/22, equipment category 3 Gas Dust)

IECEx (Zones 2/22, equipment category 3 Gas Dust) -

UKEX - Planned *1

KCs - Planned *1

NEPSI → CCC-Ex - Planned *1

RCM (C-Tick) -

EAC (GOST-R)

RoHS for EU

RoHS for China

REACH

CCC                            *apply for CCC exemption - -

KC

Marine - DNV, ABS, BV, NK, CCS, KR: Planned *1

WEEE

*1: Please contact our Customer Service for the latest information.
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2-3. Interface Compatibility 

.

*1: CANopen interface and CANopen LED will be supported. Please contact our Customer Service for the latest information.

NOTE: Please be careful when replacing, as the wiring will change significantly. Please check STC6000 Series Hardware Manual for details such as interface specifications and pin assignments

GP-3300T/L (FLEX NETWORK)

10-1

④

10-2

STC-6300TA Rear

STC-6300TA Bottom

STC-6300TA Right

STC-6300TA Top

⑨

⑫

⑩

⑬
①

②⑤⑥

④ ⑪

GP-3300T/L (FLEX NETWORK) STC-6300TA

① Power Connector (DC) Power Connector (DC)

② Serial Interface (COM1) Serial Interface (COM1)

③ Serial Interface (COM2) -

④ Ethernet Interface Ethernet Interface

⑤ USB (Type A) Interface USB (Type A) Interface

⑥ - USB (micro-B) Interface

⑦ CF Card Interface -

⑧ Expansion Unit Interface (for expansion units) -

⑨ - DIO Interface

⑩ 10-1: FLEX NETWORK Interface, 10-2: FLEX NETWORK Status LED Expansion Module Interface (for TM3 / EX module connection)

⑪ - CANopen Interface *1

⑫ - CANopen LED *1

⑬ - Battery Slot

https://www.proface.com/en/download/stc6000/manual/hardware
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2-4. Installation Method Compatibility

Panel cut dimensions and installation method are the same between GP-3300T/L and STC-6300TA.

GP-3300T/L STC-6300TA

The product can be installed easily by using a screwdriver. 

The necessary torque is 5 N•m.

Insertion slots

The product can be installed easily by using a screwdriver.

The necessary torque is 5 N•m.

NOTE: Installation fastener of GP-3300 (P/N: CA3-ATFALL-01) cannot be used for STC-6300TA. For STC-6300TA, please use the fastener of STC6000 Series (P/N: PFXZC3AT1). 

Please check STC6000 Hardware Manual for installation requirements and procedure. 

Installation Panel

Hook
Insertion slots

■Panel Cut Dimensions

A: 156 mm (+1/-0 mm)

B: 123.5 mm (+1/-0 mm)

C: 1.6～5.0 mm

■Panel Cut Dimensions

A: 156 mm (+1/-0 mm)

B: 123.5 mm (+1/-0 mm)

C: 1.6～5.0 mm

https://www.proface.com/en/download/stc6000/manual/hardware
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2-5. Option compatibility – Serial Interface

Product Name GP-3300T/L STC-6300TA Description Compatibility

RS-232C Cable (5m) CA3-CBL232/5M-01 CA3-CBL232/5M-01 Cable for RS-232C connection between various hosts and this product

RS-422 Cable (5m) CA3-CBL422/5M-01 CA3-CBL422/5M-01
Cable for RS-422 connection between various hosts and this product 

(Socket Type)

RS-422 Cable (5m) CA3-CBL422-01 CA3-CBL422-01
Cable for RS-422 connection between various hosts and this product 

(Plug Type)

Mitsubishi PLC A-Series 

Connection Cable (5m)
CA3-CBLA-01 CA3-CBLA-01 Cable for directly connecting an A Series CPU

Mitsubishi PLC Q-Series

Connection Cable (5m)
CA3-CBLQ-01 CA3-CBLQ-01 Cable for directly connecting a Q Series CPU

Mitsubishi PLC Q-Series Link 

Cable (5m)
CA3-CBLLNKMQ-01 CA3-CBLLNKMQ-01 Cable for directly connecting a Q Series Link Unit

Mitsubishi PLC FX-Series

Connection Cable

CA3-CBLFX/1M-01 (1m)

CA3-CBLFX/5M-01 (5m)

CA3-CBLFX/1M-01 (1m)

CA3-CBLFX/5M-01 (5m)
Cable for directly connecting an FX Series CPU

Omron PLC SYSMAC Link Cable 

(5m)
CA3-CBLSYS-01 CA3-CBLSYS-01 Cable for directly connecting a SYSMAC Link Unit

Siemens TTY Converter Cable 

(5m)
CA6-CBLTTY/5M-01 CA6-CBLTTY/5M-01 Cable for connecting a PLC S5 series to this product

MPI Cable (3.5m)

ST03-A2B-MPI21-PFE

GP3000-MPI21-PFE

CA3-MPI-PG1-PFE

CA3-MPI-PGN-PFE

ST03-A2B-MPI21-PFE Connects a host controller to this product for MPI communication.

Multi-Link Cable (5m)

CA3-CBLMLT-01

* End of sale

CA3-CBLMLT-01

* End of sale Connects a host controller to this product for multi-link (n:1) 

communication.
- PFXZCBCBML1 NEW



Page 20© 2023 Pro-face. All Rights Reserved. | 

Public

2-5. Option compatibility – Serial Interface

Product Name GP-3300T/L STC-6300TA Description Compatibility

RS-232C 9-pin/25-pin Conversion Cable 

(20cm)
CA3-CBLCBT232-01 CA3-CBLCBT232-01 Cable for converting a D-Sub 9-pin plug to a D-Sub 25-pin socket

RS-422C 9-pin/25-pin Conversion Cable 

(20cm) 

CA3-CBLCBT422-01 

*End of sale

CA3-CBLCBT422-01 

*End of sale Cable for converting a D-Sub 9-pin plug to a D-Sub 25-pin socket

NEW- PFXZCBCBCVR41

2 Port Adapter Cable (5m) 

CA3-MDCB11 

*End of sale

CA3-MDCB11 

*End of sale Connects Mitsubishi PLC to this product using 2 port adapter II (RS-

422).
- PFXZCBCBMD1 NEW

Mitsubishi PLC A, QnA, FX Series

2 Port Adapter II 

GP070-MD11

*End of sale

GP070-MD11 

*End of sale

Allows simultaneous use of this product and a Mitsubishi PLC A, 

QnA, FX Series peripheral device.

COM Port Conversion Adapter 

CA3-ADPCOM-01

*End of sale

CA3-ADPCOM-01

*End of sale Connects optional RS-422 communication items to serial interface.

- PFXZC3ADCM1 NEW

RS-422 Terminal Block Conversion 

Adapter
- PFXZCBADTM1

Connects output from a serial interface (D-sub 9 pin plug) directly to 

an RS-422 terminal block.
NEW

Terminal Block Conversion Adapter CA3-ADPTRM-01 CA3-ADPTRM-01
Connects output from a serial interface (D-sub 9 pin socket) directly 

to an RS-422 terminal block.

RS-232C Isolation Unit *1 CA3-ISO232-01 CA3-ISO232-01
Connects a host controller to this product and provides isolation

(RS-232C and RS-422 are switchable).

RS-485 Isolation Unit CA3-ISO485-01 -
Connects a host controller to this product with provides isolation.

(RS-422 and RS-485 are switchable.)
-

On-line adapter CA4-ADPONL-01 -
Terminal adapter in the case of performing RS-422/RS-485 

communication at COM2 port.
-

Siemens COM Port Conversion Adapter CA3-ADPSEI-01 - Connects Siemens PLCs to the AGP. (for RS-485 communication) -

*1 To use RS-232C Isolation Unit, set the pin #9 of COM port to VCC.
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2-5. Option compatibility – USB Interface

Product Name GP-3300T/L STC-6300TA Description Compatibility

USB Transfer Cable (2m) CA3-USBCB-01 -
Cable for transferring screen data between a PC (USB Type A) and this 

product (USB Type A)

-

A to A screen transfer 

is not available.

USB Transfer Cable - PFXZUSCBMB2
Cable for transferring screen data from a PC (USB Type A) to this product 

(USB micro-B)
NEW

USB Cable (5m) FP-US00 FP-US00 Connects a USB printer (Type B)

USB Front Cable (1m) CA5-USBEXT-01 CA5-USBEXT-01 Extension cable that attaches USB interface (Type A) to front panel

USB (micro-B) Front Cable - PFXZCIEXMB2 Extension cable that attaches USB interface (micro-B) to front panel NEW

USB Clamp Type A (1 port) - PFXZCBCLUSA1 Clamp to prevent disconnection of USB cable (USB/A, 1 port, 5 clamps/set) NEW

USB-Serial (RS-232C) Conversion 

Cable (0.5m)
CA6-USB232-01 CA6-USB232-01 Cable for converting a USB interface into a serial interface (RS-232C)

USB/RS-422/485 Conversion 

Adapter
- PFXZCBCBCVUSR41

Adapter for connecting this product (USB Type A) to an external device 

(RS-422/RS-485)
NEW

EZ Tower Light tube mounting

fixing plate
PFXZCETWHA1 *1 PFXZCETWHA1 

USB Connection Type Monolithic EZ Tower Light tube mounting with fixing 

plate 3 tiers, Ø60, lighting and flashing with a buzzer

EZ Tower Light with base mounting PFXZCETWW1 *1 PFXZCETWW1
USB Connection Type Monolithic EZ Tower with base mounting 3 tiers, 

Ø60, lighting and flashing with a buzzer

EZ Illuminated Switch - PFXZCCEUSG1
A unit of 5 illuminated switches with multiple color LED easily connected 

with this product unit via USB
NEW

EZ LAN Adapter - PFXZCGEUUE1 An adapter to expand an Ethernet port to HMI NEW

*1: This product cannot use for GP-3300 Series that is before Rev.3.
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2-5. Option compatibility – Other options

Product Name GP-3300T/L STC-6300TA Description Compatibility

CF Card (128MB) CA3-CFCALL/128MB-01 -

CF Card to insert into the CF card slot of this product.

-

CF Card (256MB) CA3-CFCALL/256MB-01 - -

CF Card (512MB) CA3-CFCALL/512MB-01 - -

CF Card (1GB) CA3-CFCALL/1GB-01 - -

CF Card (2GB) CA3-CFCALL/2GB-01 - -

CF Card Adapter GP077-CFAD10 - Used for read/write of CF Card data via a PC’s PCMCIA slot. -

Screen Protection Sheet
CA3-DFS6-01 -

Disposable, dirt-resistant sheet (5 sheets/set).

NEW

Use the option for 

STC6000 series.- PFXZCBDS61

UV Protection Sheet - PFXZCFUV61
Sheet to protect the display from ultraviolet light, for 5.7-inch screen

(1 sheet).
NEW

Protective Cover CA4-DCMDL-01 -
The installation of the cover is to protect Display from leaking liquid

and raise resistant performance against chemical substance (5 sheets)
-

Environment Cover PFXZCBOP61 Disposable, environmental resistant cover for 5.7-inch screen (1 sheet). NEW

Product Name GP-3300T/L STC-6300TA Description Compatibility

TM3 Ethernet Bus Coupler - TM3BCEIP
distributed IO module, Modicon TM3, IP20 optimized bus coupler, 

Ethernet interface
NEW

Transmitter - TM3XTRA1 Remote transmitter module NEW

Receiver - TM3XREC1 Remote receiver module NEW
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2-5. Option compatibility – Expansion Unit

Product Name GP-3300T/L STC-6300TA Description Compatibility

PROFIBUS-DP Slave Unit
PFXZC5EUPFS 

(CA5-PFSALL/EX-01)
-

Expansion Unit for connecting GP to PROFIBUS network or 

communicating with a PROFIBUS-DP master.
-

Device Net Slave Unit
PFXZC6EUDNS1

(CA6-DNSALL/EX-01)
-

Expansion Unit for connecting GP to DeviceNet network or 

communicating with a DeviceNet master.
-

CC-Link Unit
PFXZC7EUCL1

(CA7-CCLALL/EX-01)
-

Expansion Unit for connecting GP to CC-Link network or communicating 

with a CC-Link master.
-

CANopen Slave Unit
PFXZC9EUCA1

(CA9-CANALL/EX-01)
-

Expansion unit, for communicating with the CANopen master and 

connecting the GP to a CANopen network.
-

NOTE: These expansion units for GP-3300T/L cannot be used for STC-6300TA.
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2-5. Option compatibility – FLEX NETWORK I/O units

Product Name GP-3300T/L STC-6300TA Description Recommended TM3 module

FLEX NETWORK 

16-Point Input Sink Source Type I/O Unit 
FN-X16TS41 
*End of sale before 2011/12/31

Use TM3 

module

16-point sink/source shared I/O Unit. 

DC24V input signal can be connected.
TM3DI16

FLEX NETWORK 

32-Point Input Sink Source Type I/O Unit 

PFXZFNX32TS

(FN-X32TS41)
Use TM3 

module

32-point sink-source shared I/O Unit. 

DC24V input signal can be connected.
TM3DI32K

FLEX NETWORK 

16-Point Output Sink Type I/O Unit 
FN-Y16SK41
*End of sale before 2011/12/31

Use TM3 

module
16-point output sink I/O Unit. TM3DQ16UK

FLEX NETWORK 

16-Point Output Source Type I/O Unit 
FN-Y16SC41 
*End of sale before 2011/12/31

Use TM3 

module
16-point output source I/O Unit. TM3DQ16TK

FLEX NETWORK 

8-Point Input Sink Source / 8-Point Transistor 

Output Sink Type I/O Unit

FN-XY08TS41 
*End of sale before 2011/12/31

Use TM3 

module

8-point input sink-source and 8-point transistor output sink 

mixed I/O unit.

Both DC24V input signals and DC24V output (load current: 

200mA max.) devices can be connected.

TM3DI8

TM3DQ8U

FLEX NETWORK 

16-Point Input Sink Source / 16-Point Transistor 

Output Sink Type I/O Unit

PFXZFNXY16K

(FN-XY16SK41)

Use TM3 

module

16-point input sink-source and 16-point transistor output 

sink mixed I/O unit.

Both DC24V input signals and DC24V output (load current: 

200mA max./1.6A/common) devices can be connected.

TM3DI16

TM3DQ16UK

FLEX NETWORK 

16-Point Input Sink Source / 16-Point Transistor 

Output Source Type I/O Unit

PFXZFNXY16C

(FN-XY16SC41)

Use TM3 

module

16-point input sink-source and 16-point transistor output 

source mixed I/O unit.

Both DC24V input signals and DC24V output (load current: 

200mA max./1.6A/common) devices can be connected.

TM3DI16

TM3DQ16TK

FLEX NETWORK 

32-Point Input Sink Source / 32-Point Transistor 

Output Sink Type I/O Unit

PFXZFNXY32K

(FNXY32SKS41)

Use TM3 

module

32-point input sink-source and 32-point transistor output 

sink mixed I/O unit.

Both DC24V input signals and DC24V output (load current: 

200mA max./1.6A/common) devices can be connected.

TM3DI32K

TM3DQ32UK

FLEX NETWORK 

8-Point Relay Output / 1 Common Type I/O Unit 
FN-Y08RL41
*End of sale before 2011/12/31

Use TM3 

module

8-point relay output (1 common) I/O Unit.

Up to AC240V (1A) load current can be connected.
TM3DQ8R
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*1 There’s some specification differences between FLEX NETWORK and TM3 analog units. For the details, refer to Analog Unit Comparison – FLEX NETWORK vs TM3 in this document. 

2-5. Option compatibility – Option for FLEX NETWORK type

Product Name GP-3300T/L STC-6300TA Description Recommended TM3 module

FLEX NETWORK 2-Channel

Analog/Digital Conversion Input Unit

PFXZFNAD2

(FN-AD02AH41)
Use TM3 

module
Converts 2-channel analog signals to digital signals at 12-bit resolution. TM3AI2H *1

FLEX NETWORK 2-Channel

Digital/Analog Conversion Output Unit

PFXZFNDA2

(FN-DA02AH41)
Use TM3 

module
Converts 2-channel 12-bit digital signal to analog signal and sends output. TM3AI4 *1

FLEX NETWORK 4-Channel

Analog/Digital Conversion Input Unit

PFXZFNDA3

(FN-AD04AH11)

Use TM3 

module
Converts 4-channel analog signals to digital signals at 12-bit resolution. TM3AQ2 *1

FLEX NETWORK 4-Channel

Digital/Analog Conversion Output Unit

PFXZFNDA4

(FN-DA04AH11)

Use TM3 

module
Converts 4-channel 12-bit digital signal to analog signal and sends output. TM3AI4 *1

Product Name GP-3300T/L STC-6300TA Description Compatibility

FLEX NETWORK

Single-Axis Positioning Unit
FN-PC10SK41
*End of sale before 2011/12/31

-
Both of this unit and GP can store positioning data. 

Motor driver connection cable (FNPC10CB01) is required.
-

Teaching Loader for Single-Axis

Positioning Unit
FN-PC10LD41
*End of sale before 2011/12/31

-

Programmer for Single-Axis Positioning Unit.

Allows entry, editing and operation checking of high-precision positioning 

data. (5m cable included)

-

FLEX NETWORK

High Speed Counter Unit
FN-HC10SK41
*End of sale before 2011/12/31

-
High performance High-Speed counter that can easily change counter 

input types. Can create both a wide range of data and cam output.
-

FLEX NETWORK Communication 

Cable

FN-CABLE2010-31-MS (10m) 
*End of sale before 2011/12/31

-

Connect GP units with FLEX NETWORK units.

-

PFXZCBFN50 (50m)

(FN-CABLE2050-31-MS)
- -

PFXZCBFN200 (200m)

(FN-CABLE2200-31-MS)
- -

Motor Driver Connection Cable
FN-PC10CB01 (1m) 
*End of sale before 2011/12/31

-
Connects the FLEX NETWORK single-axis positioning unit and the servo 

and stepping drivers.
-
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2-5. Option compatibility – Maintenance options

Product Name GP-3300T/L STC-6300TA Description Compatibility

Installation Fastener
CA3-ATFALL-01 -

Installation fastener (4 pieces/set)

NEW

Use the option for 

STC6000 series.- PFXZC3AT1

Installation Gasket
CA3-WPG6-01 - Provides dust and moisture resistance

when this product is installed into a solid panel (1 piece).

NEW

Use the option for 

STC6000 series.- PFXZHWG31

Connector Cover CA3-BUSCVR-01 - Protects this product’s rear face connector -

USB Cable Clamp (1 port) CA5-USBATM-01 - USB Cable clamp for 2 port products to prevent disconnection -

DC Power Supply Connector CA5-DCCNM-01 CA5-DCCNM-01 Connector to connect DC power supply cables

Battery for Data Backup - PFXZGEBT1 Primary battery for memory and time data backup (1 piece) NEW

Panel Cutout Adapter CA4-ATM5-01 -
Panel cutout adapter for mounting GP-3300 series in cutout of 

GP-37W2B
-

DIO Connector - PFXZC7CNXY321 Connectors for interfacing with external I/O devices (5 pieces/set). NEW

TM3 Module Securing Hook - PFXZHMSH1 TM3 module securing hook (1 piece) NEW

FLEX NETWORK Connector CA6-FNCNALL-01 -
Connector attached to the FLEX NETWORK interface. Connects the FLEX

NETWORK communication cable. (Set of 5 connectors)
-

Single-Axis Teaching Loader 

Cable
FN-LD10CBL (5m)
*End of sale before 2011/12/31

-
Connects the FLEX NETWORK single axis positioning unit and the single-

axis teaching loader.
-
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2-6. Other Important Notes on Hardware

• About Serial Interface

• The Serial Interface specifications (such as pin assignment and the shape of plug/socket) of STC-6300TA are different from 

GP-3300T/L. For the details, refer to STC6000 Hardware Manual.

• The RS-232C/422/485 device that was connected via COM1 on GP-3300T/L will be connected via COM1 on STC-6300TA.

(The same cable connection can be used.)

• The RS-422/485 device that was connected via COM2 on GP-3300T/L will be connected via COM1 on STC-6300TA. 

(The same cable connection can be used, but conversion cable is required.) 

Before STC-6300TA is connected, be sure to change the port setting to "COM1" in "Device/PLC Settings“ on GP-Pro EX. 

Also, please check the communication settings again with "GP-Pro-EX Device/PLC Connection Manual“ just in case.

• If you have configured GP-3300T/L to connect both COM1 and COM2 to connected devices, you will only be able to connect 

them via COM1 when replacing to STC-6300TA. In this case, change either COM1 or COM2 to other communication method.

• By using “USB/RS-422/485 Conversion Adapter”, you can use the USB interface of STC-6300TA as RS-422/485 Serial 

Interface. For the details, refer to “USB/RS-422/485 Conversion Adapter Installation Guide”.

As the connectable devices with USB/RS-422/485 Adapter are limited, please also refer to “USB/RS-422/485 Conversion 

Adapter Connection Guide” to see the list of supported drivers.

https://www.proface.com/en/download/stc6000/manual/hardware
https://www.pro-face.com/otasuke/files/manual/gpproex/new/device/index.htm
https://www.pro-face.com/otasuke/files/manual/gp_option/PFXZCBCBCVUSR41-MT01_eng.pdf
https://www.pro-face.com/otasuke/files/manual/gpproex/new/device/data/com_usc.pdf
https://www.pro-face.com/otasuke/files/manual/gpproex/new/device/data/com_usc.pdf
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2-6. Other Important Notes on Hardware

• Do not expose the hardware to direct sunlight. Recommend to use the option item “UV Protection Sheet” to protect the 

display from ultraviolet light.

• This product is not designed for outdoor use. UL certification obtained is for indoor use only.

• Do not turn on the hardware if condensation has occurred inside the device.

• The panel brightness may decrease when used for a long time in an environment continuously filled with inert gas. 

Please ventilate the control panel periodically.



Page 29© 2023 Pro-face. All Rights Reserved. | 

Public

2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver

• System configuration – GP-3300T/L FLEX NETWORK type

• System configuration – STC-6300TA + TM3 modules

FLEX NETWORK related options 

cannot be used for STC-6300TA.

Able to connect up to 2 units of TM3 modules 

on the rear of STC-6300TA

Extension mounting with Transmitter and Receiver when connecting 3 units or more of TM3 modules
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2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver

* When mounting one TM3 module and one transmitter module on the rear of STC6000 Series, mount TM3 module first, and then mount the transmitter module as a 2nd unit.

⚫ Up to 8 modules can be connected by the following configuration (1x TM3 on rear, 7x 

TM3 by Extension Mounting)

⚫ Up to 7 modules can be connected after Receiver module.

NOTE：For configuration method, refer to  Chapter 10 “When using TM3 modules as local expansion I/O with STC6000” in Modicon TM3 guidebook for 

setting up a connection to HMI.

The following option items are required to connect TM3 modules by 

Extension mounting.

Reference Description / Usage / Length etc.

TM3XTRA1 Modicon TM3 Remote Transmitter Module

TM3XREC1 Modicon TM3 Remote Receiver Module

ACTPC6FULS05WE Cat6 Patch Cord 

F/UTP LSZH, 
WHITE

Cable for connecting the 
Transmitter to the Receiver.

0.5m

ACTPC6FULS10WE 1m

ACTPC6FULS20WE 2m

ACTPC6FULS30WE 3m

ACTPC6FULS50WE 5m

https://www.proface.com/en/download/guidebook/tm3
https://www.proface.com/en/download/guidebook/tm3
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2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver

Type TM3 module name

Screw type Spring type HE10

Digital Input Module TM3DI8 TM3DI8G -

TM3DI8A -

TM3DI16 TM3DI16G TM3DI16K

- - TM3DI32K

Digital Output Module TM3DQ8R TM3DQ8RG -

TM3DQ16R TM3DQ16RG -

TM3DQ8U TM3DQ8UG -

TM3DQ8T TM3DQ8TG 

TM3DQ16U TM3DQ16UG TM3DQ16UK

TM3DQ16T TM3DQ16TG TM3DQ16TK

- - TM3DQ32UK

- - TM3DQ32TK

Digital Input / Output 

Module

TM3DM8R TM3DM8RG -

TM3DM24R TM3DM24G -

Analog Module TM3AI2H TM3AI2HG -

TM3AI4 TM3AI4G -

TM3TI4 TM3TI4G -

TM3TI4D TM3TI4DG -

TM3AI8 TM3AI8G

TM3TI8T *1 TM3TI8TG *1

TM3AQ2 TM3AQ2G 

TM3AQ4 TM3AQ4G

TM3TM3 TM3TM3G

TM3AM6 TM3AM6G

*1 Plan to be supported

Connectable TM3 Modules when using TM3 Driver :

For a list of recommended TM3 modules 

as a substitute of FLEX NETWORK unit, 

please refer to 2-5. Option Compatibility – 

FLEX NETWORK I/O units.
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• System Configuration – GP-3300T/L FLEX NETWORK Type

• System Configuration – STC-6300TA + TM3BCEIP + TM3 Module

2-8. TM3 Connection with EtherNet/IP – When using [EIP driver] as the I/O driver (use TM3BCEIP)

FLEX NETWORK related options 

cannot be used for STC-6300TA.

For a list of recommended TM3 modules as a 

substitute of FLEX NETWORK unit, please refer 

to 2-5. Option Compatibility – FLEX NETWORK 

I/O units.

All TM3 modules supported by TM3BCEIP can be 

used for this EtherNet/IP connection.

Safety modules (Modicon TM3 Safety) can also be 

connected. For details, refer to the TM3BCEIP 

hardware manual.
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2-8. TM3 Connection with EtherNet/IP – When using [EIP driver] as the I/O driver (use TM3BCEIP)

Below is the configuration overview to connect STC-6300TA with TM3BCEIP.

Configure TM3BCEIP by TM3BC IO Configurator.
SPF file

EDS file

Download the configuration to 

TM3BCEIP via USB

Select [EIP Driver] as the I/O 

Driver. Import the EDS file to GP-

Pro EX and set up the network 

configuration, etc.

Download the project to 

STC-6300TA
For the detailed setup procedure, please refer to 

Modicon TM3 guidebook for setting up a connection to HMI. 

https://www.proface.com/en/download/guidebook/tm3


Page 34© 2023 Pro-face. All Rights Reserved. | 

Public

3. Software Section
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3-1. Replacement Procedure – Workflow
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Check the 

compatibility of 

the hardware with 

Replacement 

Guidebook.

Remove the 

unit in use.

Install 

recommended 

substitute unit.

Connect the 

Power Supply

Check the 

performance 

and start 

operation.

Receive 

screen data 

from the unit in 

use.

Change the model 

type of the received 

screen data using 

GP-Pro EX.

Check and 

modify the data 

on GP-Pro EX.

Transfer the 

screen data to the 

recommended 

substitute unit.

Check the connection 

between the recommended 

substitute unit and a PLC in 

the GP-Pro EX Device/PLC 

Connection Manual.

Start connection 

and check the 

communication

Connect the 

recommended 

substitute unit 

and PLC with 

the PLC’s cable.
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3-1. Replacement Procedure – Preparation

*1: This step is required if screen data is saved only in the HMI unit, not in any other device.

     If you already have the screen data backup, please go to “3-1. Replacement Procedure – Change model to recommended substitute unit (GP-Pro EX)”.

*2: Please use the same or later version of the software used when creating screens on the old model. If you don’t know the software version, we recommend 

that you use the latest one. You can download the latest transfer tool from our website.

https://www.pro-face.com/otasuke/

Requirements for receiving screen data 

from the unit in use *1

PC in which GP-Pro EX Transfer Tool is installed. *2

Transfer Cable (the followings can be used) 

    USB transfer cable: CA3-USBCB-01 (Type A - Type A)

    *It’s also possible to send/receive a screen via CF Card, USB storage device or Ethernet.

Requirements for converting screen data 

of the unit in use and transferring the 

converted data to Recommended 

substitute unit

PC with GP-Pro EX installed

    STC-6300TA (with EIP driver/TM3 driver) supported version: Ver. 4.09.550 or later

Transfer Cable (the followings can be used) 

    USB transfer cable: PFXZUSCBMB2 (Type A – Type micro-B)

    or commercially available USB micro-B transfer cable

    *It’s also possible to send/receive a screen via USB storage device or Ethernet.

https://www.pro-face.com/otasuke/
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3-1. Replacement Procedure – Receive Screen data from the model in use (GP-Pro EX)

In this section, we will introduce how to receive screen data with a USB transfer cable as an example. If you have the backup of screen data, this step is not necessary. 

Please go to the next section.

1. Connect your PC and the model in use with a USB 

transfer cable. If the driver of the cable has not been 

installed on your PC yet, a dialog box will appear. 

Please follow the instructions.

2. Start the Transfer Tool of GP-Pro EX.

3. Make sure that the [Device] in the “Transfer Settings 

Information” is set to [USB]. If not, click the [Transfer 

Setting] button to open the “Transfer Setting” dialog 

box. Select [USB] in the Communication Port Settings 

field and click [OK].

4. Start GP-Pro EX Transfer Tool and click the [Receive 

Project] button.

5. Click [Receive Project], and the following dialog box will 

appear. Specify a place to save the received data in and 

a project file name, and then click [Save] to start 

transfer.

6. The following dialog box appears during transfer, and 

you can check the communication status. (The display 

unit enters the Transferring mode and communication 

with the device such as a PLC is terminated.)

7. When transfer is completed, the status displayed in the 

dialog box will change from [Transferring] to [Complete 

Transfer]. Click [Close] to close the dialog box.

8. Close the Transfer Tool.
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3-1. Replacement Procedure – Receive Screen data from the model in use (GP-Pro EX)

• The “Hardware Installation” dialog box as shown on the right may appear during installing the USB 

driver depending on the security level of Windows®. Click [Continue Anyway] to start installing the 

driver. When installation is completed, click [Finish].

• When the file already exists, a window will appear asking if you want to overwrite the file.

• When receiving a project file that uses SD card/USB memory data such as Recipe Function (CSV 

data), the following dialog box will appear during the transfer. Please specify where to save the data. 

Click [OK] to return to the [Receive Project] dialog box and complete the transfer.

NOTES
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3-1. Replacement Procedure – Change model to recommended substitute unit (GP-Pro EX)

Change the Display unit from GP-3300T/L to STC-6300TA.

The display can be changed from the menu bar “Project” → “System Settings” → “Display” → 

“Change Display” in GP-Pro EX.

• A function that requires absolute coordinates. Please adjust the settings manually. 

- Global window

- Position Animation

• Due to font size and resolution restrictions, manual changes may be required. Please resize them if needed

- Font: In the case of using Standard font, the size will be smaller. You can improve by using Stroke font or Image font.

- Objects 

- Parts

- Images

- Alarm parts

• Position may differ from the original project. Please check the coordinate of the window and adjust if needed.

- Window display

If you check on [Convert Resolution] when changing the Display Unit type (as shown below), you can adjust both size and 

location of the part and the text relative to the display resolution automatically. But still, you may need to adjust them manually.

Please pay attention to the following points. 
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3-1. Replacement Procedure – Transfer screen data to recommended substitute unit (GP-Pro EX)

In this section, we will introduce how to transfer screen data with a USB transfer cable as an example. 

1. Connect your PC and the recommended substitute unit 

with a USB transfer cable. If the driver of the cable has 

not been installed on you PC, a dialog box will appear. 

Please follow the instructions.

2. Turn on the power of Recommended substitute unit. 

The “Welcome” screen will appear on the display unit. 

After transferring a project file once, this screen will not 

appear again.

3. On the GP-Pro EX’s State Toolbar, click the [Transfer 

Project] icon to open the Transfer Tool.

       To transfer a different project file, click the 

       [Select Project] button and select a project file.

4. Make sure that the [Device] in the “Transfer Settings 

Information” is set to [USB]. If not, click the [Transfer 

Setting] button to open the “Transfer Setting” dialog box. 

Select [USB] in the Communication Port Settings field 

and click [OK].

5. Click [Send Project].

In the dialog box that appears, set the connection key 

and clock [OK].

  

6. When this dialog box appears, click [Yes]. This dialog 

box is not displayed when the same project file is sent 

again.

7. The transfer begins. The following dialog box appears 

during transfer, and you can check the communication 

status. (The display unit changes to Transferring mode 

and communication with the device/PLC is 

suspended.)

8. When transfer is completed, the state of the dialog box 

changes from [Transferring] to [Transfer Complete]. 

Click [Close] to close the dialog box.

9. Close the Transfer Tool

10. Click the [X] mark on top right of the screen or 

[Project] → [Exit] to close GP-Pro EX.

NOTE： If you forget the connection key, you will not be able 

to connect to the display unit. For more information about 

connection key, refer to GP-Pro EX reference manual 

(34.14.4 How the Connection Key Works).
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GP-Pro EX Feature GP-3300T/L (FLEX NETWORK) STC-6300TA

Display

Screen Area (Application memory, unit: byte) 6M 64M

Portrait Installation

Function Expansion Memory - -

Installing the USB/RS-422/485 Conversion Adapters -

MAC Address Display

External 

Storage

CF Card -

SD Card - -

CFast Card - -

USB storage

FTP server

System 

Settings

Drawing in 256 colors (GP-3300T/S only)

Reverse Display (GP-3300L only) - 

Color Blink (GP-3300T/S only) - 

Synchronize Text Display with Text Table *1

Time Zone settings - -

Detect Backlight Burnout -

Dimmer settings -

2-point touch / Multitouch - -

Display the SD/USB Removal Icon -

3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison

Specification UP in STC-6300TA

NOT supported in STC-6300TA

*1 Only runs on display units Rev.4 or later.
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GP-Pro EX Feature GP-3300T/L (FLEX NETWORK) STC-6300TA

System Settings

Screen Capture

SRAM Auto Backup
USB storage can be used for the 

models without SD/CF card slots.

Image Font *1

Bitmap Font *1

Standard Font *1

Port Control -

Device/PLC 

Communication *2

Number of Devices/PLCs that can communicate 

simultaneously
2 2

Specify Indirect Device  *1

Import Device/PLC tags -

Ethernet Multilink  *1*3

Device Monitor

Ladder Monitor - -

Transfer

Network Transfer

Modem Transfer - 

SIO Transfer (COM Connection) - 

Memory loader feature

CF/SD Card Connection -

Connection Key -

3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison

Specification UP in STC-6300TA

NOT supported in STC-6300TA

*1 Only runs on display units Rev.4 or later. 

*2 Depends on the type of connected PLC/Device. 

*3 If this model is used as a master station, performance may deteriorate.
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GP-Pro EX Feature GP-3300T/L (FLEX NETWORK) STC-6300TA

Common 

Settings

Change Backlight Color - -

Clock Update Settings -

Start Screen Settings -

Date format on CSV file output  *1

Divide destination folders by file numbers  *1

Increase Alarm Type [Extended] settings and Text Table index 

numbers
- -

Alarm Message Multiple Line Display  *1

Attach Data Value to Operation Log  *1

Changing passwords at run time (CSV file)  *1

Changing passwords at run time (password change screen) -

Append Date/Time to CSV File Name -

Transfer sampling CSV file to FTP -

Transferring sampled data to the cloud -

Indirectly specify Sampling Frequency and Alarm Settings  *1

Sampling data/Enhanced recipe data format co-exist -

Create a recipe (CSV data) index file at runtime  *1

Enhanced Recipes -

Extended Script copy file function  *1

Global Trigger -

3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison

Specification UP in STC-6300TA

NOT supported in STC-6300TA

*1 Only runs on display units Rev.4 or later.
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GP-Pro EX Feature GP-3300T/L (FLEX NETWORK) STC-6300TA

Common 

Settings

Movie record/play feature - -

Use Image unit - -

Sound Output Feature - -

AUX - -

Retentive Variables Function

Parts

Selector List  *1

XY Graph (Historical Trend, Data Block Display Graph)  *1 -

Picture Display [CF Image Display] / [SD Image Display] for 

showing JPEG files
USB storage can be used for the 

models without SD/CF card slots.

Indirectly specify a block of Alarm parts  *1

Special Data Display [File Manager] sort function and default 

path
 *1

Special Data Display [File Manager] copy file to FTP  *1

Message Display’s Bulletin Message  *1

Image Sensor Display  *1 -

Animation  *1

Alarm History Message Flow Display -

Alarm History / Sampling Data / Enhanced Recipe Data 

Refine Search / Sort Function
- -

Alarm Analysis Function - -

3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison

Specification UP in STC-6300TA

NOT supported in STC-6300TA

*1 Only runs on display units Rev.4 or later.
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GP-Pro EX Feature GP-3300T/L (FLEX NETWORK) STC-6300TA

Logic

Logic Program Operation

I/O Driver

Function Block

Network

RPA Function (end of support from Ver.4.09.400) - -

GP-Viewer EX

Web Server (end of support from Ver.4.09.450) - -

Camera-Viewer EX - -

Pro-face Remote HMI -

E-mail -

GP Remote Printer Server

Pro-face Connect

 (models you can register as SiteManager)
-

Pro-Server EX *1

Input 

Equipment / 

Peripheral 

Equipment 

(USB Device)

USB Keyboard

EZ Illuminated Switch -

EZ Tower Light -

EZ LAN Adapter -

3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison

Specification UP in STC-6300TA

NOT supported in STC-6300TA

*1 To use Pro-Server EX with STC-6300TA, GP-Pro EX Ver.4.09.550 or later is required.
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3-2. Software Compatibility – Supported Software Version

Supported Software GP-3300T/L 

(FLEX NETWORK)

STC-6300TA Compatibility of 

Project Data

GP-Pro EX
Ver. 4.09.550 or later

https://www.pro-face.com/otasuke/files/manual/gpproex/new/refer/gpproex.htm

Pro-Server EX
Ver. 1.37.300 or later *1

https://www.pro-face.com/otasuke/files/manual/soft/server_ex/v1_37/ref/SRPreface.htm

Pro-face Remote HMI 

(iOS/Android) 

- Ver. 1.60 or later
NEW

- https://www.pro-face.com/otasuke/qa/remotehmi/faq.html

Pro-face Remote HMI Client 

for Win 

- Ver. 1.42 or later
NEW

- https://www.proface.com/en/product/soft/remotehmi_client/download

Pro-face Connect 
- Ver. 9.6 or later

NEW
- https://www.proface.com/en/product/soft/proface_connect/download

*1 To use Pro-Server EX with STC-6300TA, GP-Pro EX Ver.4.09.550 or later is required.

https://www.pro-face.com/otasuke/files/manual/gpproex/new/refer/gpproex.htm
https://www.pro-face.com/otasuke/files/manual/soft/server_ex/v1_37/ref/SRPreface.htm
https://www.pro-face.com/otasuke/qa/remotehmi/faq.html
https://www.proface.com/en/product/soft/remotehmi_client/download
https://www.proface.com/en/product/soft/proface_connect/download
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3-3. Other Important Notes on Software

• About I/O Driver settings

• Since the I/O drivers used are different, the I/O driver settings set in the GP-3300T/L (FLEX NETWORK) project will not be 

carried over to the STC-6300TA after conversion. You need to configure the I/O driver settings on the software again. For 

information on how to set up the I/O driver, please refer to Modicon TM3 guidebook for setting up a connection to HMI.

FLEX NETWORK Driver is used in GP-3300T/L (FLEX) Project

After converting to STC-6300TA

The default setting is EXM driver.
In [Change I/O Driver] window, change the [I/O 

Driver] to [TM3 Driver] or [EIP Driver].

TM3 Driver – When connecting TM3 modules to 

STC-6300TA by Rear/Extension Mounting

EIP Driver – When connecting TM3 modules 

using EtherNet/IP compatible adapter unit

https://www.proface.com/en/download/guidebook/tm3
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3-3. Other Important Notes on Software

• About Display colors (GP-3300L only) 

• The display color of GP-3300L is monochrome. As STC6000 Series do not support monochrome display, if you change the 

model to STC6000 Series, the display color will be changed to Color display. Therefore, after changing the model, be sure 

to check the color of the screen data with GP-Pro EX.
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3-3. Other Important Notes on Software

• About Blink function

• STC6000 Series do not support Blink function. Therefore, if you use the blink settings in GP3000 Series, the settings will be 

cancelled after changing the display to STC6000 Series in GP-Pro EX.

NOTE: We have a workaround to add blink functions to some of the parts/texts on STC6000 display by using the functions of the 

configuration software, GP-Pro EX. Refer to the following FAQ for the setting procedures.

https:/www.proface.com/en/support/faq/FAQ000268649

GP3000 Series After converting the project to STC6000 Series

https://www.proface.com/en/support/faq/FAQ000268649
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3-3. Other Important Notes on Software

• Changing the setting of the external media to use 

• If a CF card is used for GP-3300 series, after the display unit type of the project file is changed to STC6000 series, “a CF card” is automatically 

replaced with “a SD card” for the external media setting. However, STC-6300TA does not support SD card.

After conversion of the project file data, at GP-Pro EX Error Check, if the message, “The project contains features that require a SD card. However, 

the selected display does not support SD cards so these features will not run.” appears, change the SD card setting to the USB storage setting 

following the procedure below. 

3） Click the [Browse] button and specify a destination folder.

4）Click [OK] to confirm the setting. 

5）Click [Project]->[Save] to save changes.

6）Check each function that uses the CF Card and replace the setting with [USB Storage].

< Procedure >

1) Click [Project] → [Information] → [Destination Folder] 

2) Uncheck “Enable SD Card” and check “Enable USB Storage”.
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Appendix
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Analog Unit comparison – FLEX NETWORK vs TM3 – 1/2

FLEX NETWORK Analog Unit TM3 Analog Module

Reference Channels Specifications Reference Channels Specifications

FN-AD02AH 2ch IN Mode 0-10V

0-20mA

4-20mA

TM3AI2H 2ch IN Mode 0-10V

-10-10V

0-20mA

4-20mA

Resolution 12bits Resolution 16bits or 15bits + sign

Conversion time ≦ 2msec Conversion time 1msec/ch

Calibration None Calibration None

Filter 2/4/8/16/32/64ms

(Moving average)

Filter 1 - 1000 (10ms unit)

FN-AD04AH 4ch IN Mode 0-5V

1-5V

0-10V

-5-5V

-10-10V

0-20mA

4-20mA

TM3AI4 4ch IN Mode 0-10V

-10-10V

0-20mA

4-20mA

Resolution 12bits or 11bits + sign Resolution 12bits or 11bits + sign

Conversion time ≦ 2msec Conversion time 1msec/ch

Calibration Possible to set by CH Calibration None

Filter 2/4/8/16/32/64/128/256/512/1024/20

48/4096/8192/16384/65536ms

(Simple average/Moving average, 

Eliminate Max/Min)

Filter 1 - 1000 (10ms unit)

NOTE: For the detailed specifications, please refer to the Hardware manual of each module.
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Analog Unit comparison – FLEX NETWORK vs TM3 – 2/2

FLEX NETWORK Analog Unit TM3 Analog Module

Reference Channels Specifications Reference Channels Specifications

FN-DA02AH 2ch OUT Mode 0-10V

0-20mA

4-20mA

TM3AQ2 2ch OUT Mode 0-10V

-10-10V

0-20mA

4-20mA

Resolution 12bits or 11bits + sign Resolution 12bits or 11bits + sign

Calibration None Calibration None

Conversion time ≦ 2msec Conversion time 1msec

FN-DA04AH 4ch OUT Mode 0-5V

1-5V

0-10V

-5-5V

-10-10V

0-20mA

4-20mA

(12bit）

TM3AQ4 4ch OUT Mode 0-10V

-10-10V

0-20mA

4-20mA

(12bit)

Calibration Possible to set by CH Calibration None

Conversion time ≦ 2msec Conversion time 1msec

NOTE: For the detailed specifications, please refer to the Hardware manual of each module.



Page 54© 2024 Pro-face. All Rights Reserved. | 

Public


	スライド 1: Easy! Smooth! Replacement Guidebook
	スライド 2: Update History
	スライド 3: Legal Information
	スライド 4: Safety Information
	スライド 5: About this book
	スライド 6: About this book
	スライド 7: About this book
	スライド 8: About this book
	スライド 9: Cybersecurity
	スライド 10
	スライド 11: 1. Summary
	スライド 12: 1. Summary
	スライド 13: 2. Hardware Section
	スライド 14: 2-1. GP-3300T/L (FLEX NETWORK) vs STC-6300TA Specification Comparison -1. Basic Information-
	スライド 15: 2-1. GP-3300T/L (FLEX NETWORK) vs STC-6300TA Specification Comparison -2. Interfaces-
	スライド 16: 2-2. Standards Compatibility
	スライド 17: 2-3. Interface Compatibility 
	スライド 18: 2-4. Installation Method Compatibility
	スライド 19: 2-5. Option compatibility – Serial Interface
	スライド 20: 2-5. Option compatibility – Serial Interface
	スライド 21: 2-5. Option compatibility – USB Interface
	スライド 22: 2-5. Option compatibility – Other options
	スライド 23: 2-5. Option compatibility – Expansion Unit
	スライド 24: 2-5. Option compatibility – FLEX NETWORK I/O units
	スライド 25: 2-5. Option compatibility – Option for FLEX NETWORK type
	スライド 26: 2-5. Option compatibility – Maintenance options
	スライド 27: 2-6. Other Important Notes on Hardware
	スライド 28: 2-6. Other Important Notes on Hardware
	スライド 29: 2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver
	スライド 30: 2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver 
	スライド 31: 2-7. TM3 Connection with TM3 Driver – When using [TM3 Driver] as the I/O Driver
	スライド 32: 2-8. TM3 Connection with EtherNet/IP – When using [EIP driver] as the I/O driver (use TM3BCEIP)
	スライド 33: 2-8. TM3 Connection with EtherNet/IP – When using [EIP driver] as the I/O driver (use TM3BCEIP) 
	スライド 34: 3. Software Section
	スライド 35: 3-1. Replacement Procedure – Workflow
	スライド 36: 3-1. Replacement Procedure – Preparation
	スライド 37: 3-1. Replacement Procedure – Receive Screen data from the model in use (GP-Pro EX)
	スライド 38: 3-1. Replacement Procedure – Receive Screen data from the model in use (GP-Pro EX)
	スライド 39: 3-1. Replacement Procedure – Change model to recommended substitute unit (GP-Pro EX)
	スライド 40: 3-1. Replacement Procedure – Transfer screen data to recommended substitute unit (GP-Pro EX)
	スライド 41: 3-2. Software Compatibility – GP-Pro EX Supported Feature Comparison
	スライド 42
	スライド 43
	スライド 44
	スライド 45
	スライド 46: 3-2. Software Compatibility – Supported Software Version 
	スライド 47: 3-3. Other Important Notes on Software 
	スライド 48: 3-3. Other Important Notes on Software 
	スライド 49: 3-3. Other Important Notes on Software 
	スライド 50: 3-3. Other Important Notes on Software
	スライド 51: Appendix
	スライド 52: Analog Unit comparison – FLEX NETWORK vs TM3 – 1/2
	スライド 53: Analog Unit comparison – FLEX NETWORK vs TM3 – 2/2
	スライド 54

